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1 WELCOME 

This manual describes the installation and usage of Auto-PERCIST™, a PET Image Volume Viewer with 

Integrated PERCIST-based Computer Assisted Analysis. 

Auto-PERCIST™ is currently only available as a beta-release and is subject to frequent changes, therefore 

while every effort has been made to keep this documentation as current as possible, the actual version 

of the program which has been distributed to you may be more current than the description provided in 

this document. If you should encounter such a discrepancy, please don’t hesitate to contact the authors 

with your comments or questions at iratlab@jhmi.edu.  

We appreciate your willingness to beta-test Auto-PERCIST™ and welcome any and all feedback with 

respect to your experience using Auto-PERCIST™, from issues related to installation and/or 

documentation, to usage or feature requests. All comments should be directed to us via e-mail at 

iratlab@jhmi.edu. 

mailto:iratlab@jhmi.edu
mailto:iratlab@jhmi.edu
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2 DISCLAIMER 

Auto-PERCIST™ is a beta-release product. The use of Auto-PERCIST™ is intended for research purposes 

only, and the software is provided AS IS without any express or implied warranty. The Johns Hopkins 

University makes no warranty or representation about the suitability of the software for any reason. 

The Johns Hopkins University shall not be liable for any direct, indirect, special or consequential 

damages resulting from the loss of use, or data, or projects arising out of or in conjunction with the use 

or performance of this software. 

The Johns Hopkins University cannot give support for this software. 

It is expected that academic usage of this software will be acknowledged in publications. Questions with 

respect to support, installation, other types of usage and other aspects related to the software should 

be directed to the authors at iratlab@jhmi.edu. 

mailto:iratlab@jhmi.edu
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4 PRE-REQUISITES 

4.1 CLIENT COMPUTER 
The Auto-PERCIST™ program has been written in the Java programming language and, as such, can 

theoretically run on any computing platform for which a valid Java Virtual Machine (VM) exists. At this 

time we have only tested Auto-PERCIST™ on the Microsoft Windows (XP, 7, and 8) and Linux Ubuntu 

platforms. Any feedback on your use of Auto-PERCIST™ on alternative platforms would be most 

welcome. 

Auto-PERCIST™ runs best when executed in a 64-bit operating environment. It will run on a 32-bit 

platform but will be constrained by the memory limitations imposed by a 32-bit Java virtual machine. In 

addition, much of the computationally intense code in Auto-PERCIST™ is written to take advantage of a 

multi-core processor. The default operating mode of Auto-PERCIST™ is to take advantage of any multi-

processing abilities provided by the host processor, though this capability can be disabled by the user. 

For performance reasons we recommend you don’t disable this feature unless you experience runtime 

errors associated with multi-threading. 

4.2 DATABASE 
Auto-PERCIST™ works best when it is able to communicate with a database system for both input and 

output. With respect to input, Auto-PERCIST™ can be connected to a DICOM archive (see next sub-

section) for navigation and retrieval of image data. This connection is mediated by Auto-PERCIST™ 

communicating directly with the back-end database of the DICOM archive. With respect to output, 

Auto-PERCIST™ can store the results of its processing into a user-selectable database. This then allows 

the user to either use the supplied default reporting template for reporting of results or to develop their 

own SQL based reporting template which may be more suitable to the user’s own needs. 

The database system currently supported by Auto-PERCIST™ is the community version of the Oracle 

MySQL database. It is available for free download at: 

http://dev.mysql.com/downloads/windows/installer/.  

At this time there are no additional data management tools provided within Auto-PERCIST™ directly, 

though the download package from Oracle for MySQL includes a robust set of administrator tools for 

managing your databases. 

4.3 DICOM ARCHIVE 
Auto-PERCIST™ is able to query and retrieve image data associated with a shareware DICOM archive 

called conQuest. It is available for download at: http://ingenium.home.xs4all.nl/dicom.html. When 

conQuest is installed and configured to use the MySQL database (Section 4.2 above), Auto-PERCIST™ is 

http://dev.mysql.com/downloads/windows/installer/
http://ingenium.home.xs4all.nl/dicom.html
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able to query and retrieve image data directly from its database. This allows the user to configure their 

Auto-PERCIST™ workstation as a DICOM node to which their image data can be sent directly. The user 

can also use the conQuest interface to query and retrieve data from other DICOM nodes (though this 

capability is not provided from directly within Auto-PERCIST™ at this time). 

4.4 AUTO-PERCIST™ DOWNLOAD 

4.4.1 Download 

Please refer to the separate document entitled “Auto-PERCIST Download Instructions” for directions on 

accessing our lab’s secure FTP server and selecting the correct files for download. 

4.4.2 Installation 

Remember the installer file name (either install.exe, install.bin or install.zip, depending on your host 

platform) and the location in which this file was saved. The next section (Section 5 below) details the 

complete installation process. 
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5 INSTALLATION 

5.1 DATABASE SERVER 
You must first download the database components from 

http://dev.mysql.com/downloads/windows/installer/. The web page, as it appeared at the time of this 

writing, appears below: 

 

 

Figure 5-1 MySQL download web page 

As stated on the download web page, the installer is a 32-bit program but will install either the 32-bit or 

64-bit version of the database system depending on the architecture of your computer. 

After selecting a download option, you will be presented with a File Download – Security Warning dialog 

box. You can choose to either directly run the download or to save the download to the file system. 

http://dev.mysql.com/downloads/windows/installer/
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Figure 5-2 File Download Security Warning 

Whether you run the file directly, or save to disk and run later, does not matter. However, once you 

begin the process you may be prompted to install pre-requisite components, such as ‘Microsoft .NET 

Framework 4’, etc. (Figure 5-3).  

 

Figure 5-3 Pre-requisite Prompt 

Proceed to install the pre-requisite components if so prompted. Once all the required pre-requisites 

have been installed, run the MySQL installer again. You will be presented with a dialog box similar to the 

one below: 

 

Figure 5-4 MySQL Installer 
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Select the Install MySQL Products link to continue. Accept the license agreement and accept the online 

check for updates. When presented with the Setup Type dialog (Figure 5-5), select either the Developer 

Default or Full installation types. 

 

Figure 5-5 MySQL Setup Type Dialog 

It is easiest to just accept the default settings for the location of the database files. Once you’ve 

accepted a type of setup to perform, click Next to proceed. You may or may not be presented with 

additional pre-requisite requirements. One you have installed any additional pre-requisites, you can 

continue the installation by selecting the Execute button. 

After you have met all the system requirements you will be presented with an Installation Progress 

dialog (Figure 5-6). 

 

Figure 5-6 MySQL Installation Installer Progress 
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Select Execute to begin the download and installation process. If at first you downloaded the complete 

package and not just the internet installer package, your dialog may look a bit different, though the 

packages to be installed will be similar. 

Once the packages have installed, you will need to configure the database. You will do this in the MySQL 

Server Configuration dialog (Figure 5-7). It is easiest to just accept the default options (though make sure 

to note the TCP/IP port number on which the server is run, the default of which is 3306). During this 

process you will assign a root password for the database. Please remember this password as you will 

need it to allow both the DICOM server and Auto-PERCIST™ to connect with the system. 

 

Figure 5-7 MySQL Installer Server Configuration 

Best practices would require that you create a user account for the DICOM server and the Auto-

PERCIST™ application. If you decide to use non-root accounts for these applications, you will need to 

make sure that they are created with DB Admin roles so that they have the authority to create 

databases on the server. Accept the default settings for the remaining setup screen and complete the 

system configuration. 

5.2 DICOM ARCHIVE 
The conQuest DICOM server can be downloaded from http://ingenium.home.xs4all.nl/dicom.html. 

Multiple packages and configurations of the DICOM archive will be available for download. You should 

choose the ‘complete’ system, named ‘dicomserver####.zip’ (where ‘####’ refers to the current version, 

which at the time of the writing of this manual is ‘1417’). Download this zip file (or for Linux the tar file) 

to your computer and then extract the contents of this archive file. Be sure to select a location for the 

http://ingenium.home.xs4all.nl/dicom.html
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extracted files which has plenty of disk space as the image files sent to this archive will be stored in a 

subdirectory of this target destination. 

!!!Note: The installation described below is specific for a Windows computer based installation. You can 

also install the ‘conQuest’ archive on a Linux computer, though the process is a bit different and the 

details of a Linux installation are not provided here. However, system configuration differences are 

provided below. 

The configuration is fairly straightforward. After extracting the contents of the downloaded archive file, 

you will find the executable file named ConquestDICOMServer.exe. This is the user-interface for the 

DICOM server system. Run this program. When you run this program for the first time you will be 

possibly be presented with both security and Windows Firewall dialog boxes. Progress through these 

dialog boxes by answering in the affirmative, including allowing access through the firewall (if one is 

installed and running). 

After you have proceeded through these dialogs, you will be presented with a New Installation dialog 

(Figure 5-8) in which you will have to choose the underlying database type for the system. 

 

Figure 5-8 ConQuest DICOM Server DB Installer 

!!! IMPORTANT: Be sure to select ‘Native MySQL driver’! Upon doing so, you will be presented with the 

main archive user-interface (Figure 5-9). 
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Figure 5-9 ConQuest DICOM Server Configuration 

From this screen you can select the remaining user options and start the archive server.  

!!! NOTE: It is important to remember to NOT enable image compression for this archive. Auto-PERCIST™ 

must have access to the image data in non-compressed form!!! 

In the installation directory you will find a more detailed description of the installation and usage of this 

system in a file named windowsmanual.pdf, however the following brief description will get you started. 

!!!Note: There is also a linuxmanual.pdf file, however it only covers the installation process for Linux 

based systems and not the entirety of the configuration issues discussed in the “windowsmanual.pdf”. 

For Linux based installations, both manuals should be referenced. 

You can change the AE Title of the archive to one of your choosing, providing it is limited to 16 

characters and does not include spaces or special characters. You can also select the TCP/IP port of your 

choosing as long as it does not interfere with any other network services running on your system. A 

common desktop DICOM port setting is 104. You may want to consult with your local PACS 

administrator for network and client DICOM node configurations. 

Once you have set the AE Title and TCP/IP port press the Save Configuration button. This will install the 

back-end DICOM server and may result in an additional Windows Firewall security dialog. As before, 

allow the application to access the network. 

The dialog will now change to the Installation page (Figure 5-10). On this page you will create and test 

your archive’s database.  
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Figure 5-10 ConQuest DICOM Server Installation 

You will first verify that the network installation is working properly by selecting Verify TCP/IP 

installation’. Next you will create the database by selecting Make MySQL database.  You will be asked to 

confirm the creation of a database, to which you will reply Yes. You will then give the database a name. 

You can accept the default (CONQUEST) or select your own.  

!!! NOTE: Remember this name for later configuration of Auto-PERCIST™.  

After providing a name you will be asked for the root password of the MySQL server which you specified 

during the MySQL installation. If you entered a valid name and password, the create database process 

should have completed successfully and a message stating so should appear in the log window within 

the dialog box. To verify the database installation press the Verify database installation button. The log 

window should report a successful test of the database. To complete the process, you can re-initialize 

the database by selecting the (Re)-initialize database button. You may get error messages the first time 

you attempt this and, if you do, just try a second time. If it is not successful on a second attempt then 

you most likely have a configuration problem. Refer to the DICOM.INI configuration section (Section 

5.2.1 below) for possible solutions. At this time you should have an active DICOM archive running on 

your system. The database may be pre-populated with an example study. 

You can connect your archive to other DICOM nodes from within the Known DICOM providers tab. You 

can also access the database for management purposes from the Browse database tab, and DICOM 

Query/Retrieve functions from the Query/Move tab. Please consult the conQuest documentation and 

your local PACS administrator for configuring connectivity to additional DICOM nodes. 
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!!! NOTE: It is important to remember to NOT enable image compression when configuring DICOM nodes 

in this archive. Auto-PERCIST™ must have access to the image data in non-compressed DICOM Part 10 

format!!! 

5.2.1 DICOM.INI Configuration 

The main configuration file for the conQuest DICOM archive is a text file named DICOM.INI. It is 

automatically generated during the installation with default settings which may need to be changed to 

work properly with Auto-PERCIST™. On Windows based systems, many of these edits are accomplished 

through the user interface (Section 5.2 above). However, not all changes can be made through the user 

interface, and on Linux systems all changes must be made manually. Those changes are described 

below: 

5.2.1.1 Network Configuration 

In the Network Configuration section (Figure 5-11) of the DICOM.INI file, you will want to confirm both 

the AE Title ( ) and the DICOM Port ( ) settings for your archive. 

 

Figure 5-11 DICOM.INI Network Configuration 

5.2.1.2 MySQL Database Configuration: 

In the MySQL Configuration section (Figure 5-12), you will want to confirm the network location of the 

MySQL server ( ). If the archive is running on the same machine as the database, then the localhost 

setting is appropriate, otherwise a valid TCP/IP address is required. Next is the name of the MySQL 

database which has been established for conQuest ( ). The user name ( ) and password ( ) for an 

account with appropriate permission to access and write to the database are set. Finally, a flag to tell 

the system that the database type is MySQL ( ) should be set to 1 (meaning true) and a configuration 

setting for how to handle Back slash (‘\’) characters in strings passed to the database ( ) should also be 

set to 1. 

 

Figure 5-12 DICOM.INI MySQL Configuration 
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5.2.1.3 General Database Configuration 

In the Configure Database section (Figure 5-13), there is one setting that requires manually editing. This 

setting – FileNameSyntax - provides the syntax format which the archive should use when it saves 

received DICOM image files to the storage device. The preferred syntax to use is provided for Windows 

( ) and Linux ( ). The specified format is recommended but not required, though it is a requirement that 

the image files be stored in a DICOM Part 10 format and not in one of the alternative compressed 

formats which are also available to the conQuest archive.  

!!!Note: Auto-PERCIST™ will not be able to read compressed DICOM files!!! 

 

Figure 5-13 DICOM.INI Database Configuration 

5.2.1.4 Image Storage Configuration 

The last configuration section of DICOM.INI which requires manual attention is the setting which 

established the directory in which the received DICOM images are to be stored (Figure 5-14). This is the 

MAGDevice0 setting ( ). In the example provided here, syntax for a Windows hosted installation is 

provided. If you are installing conQuest on a Linux based machine, make sure that you use appropriate 

syntax (i.e. forward slash ‘/’ instead of back slash ‘\’) when constructing your path. Remember this 

setting as it you will need it when configuring Auto-PERCIST™ to retrieve images from your archive. 

 

Figure 5-14 DICOM.INI Image Storage Configuration 

5.2.2 ACRNEMA.MAP Configuration 

The configuration file ACRNEMA.MAP (Figure 5-15) contains the information needed to establish 

communications between your archive and other DICOM devices. 
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Figure 5-15 ACRNEMA.MAP Configuration 

The first non-commented row in the file is an entry which identifies itself ( ), all additional rows identify 

connected systems ( ). Each entry contains four (4) elements: The AE Title of the device ( ), the network 

address of the device ( ), the network port on which the DICOM service is running ( ), and the type of 

compression which is used ( ). It is important that the Compression field ( ) be set to ‘un’ 

(uncompressed) for all entries, as Auto-PERCIST™ is unable to read compressed images. 

Your system is now ready to receive images! 

5.3 AUTO-PERCIST™ 
Auto-PERCIST™ is currently available for multiple computers in multiple configuration. However, the 

only installation packages which have been tested are those for Windows-based computers. There are 

four installation packages for Windows; one set for both 32 and 64-bit operating systems, and one 

exclusively for 64-bit version of Windows. Each set contains one installation which includes an 

embedded Java Virtual Machine (VM) and one which does not. It is recommended that, unless the user 

is an expert in Java VM installation and configuration, that the installation package with the embedded 

Java VM be used. See Section 4.4 above for instructions on downloading the appropriate Auto-PERCIST™ 

installer for your system. 

When you run the installer you will once again be presented with a security dialog box (a User Account 

Control dialog). Respond in the affirmative to allow the program to proceed with the installation. After 

the installer unpacks its contents it will present the user with an Introduction to the installation of Auto-

PERCIST™ (Figure 5-16). 
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Figure 5-16 Auto-PERCIST™ Installation Introduction 

Please click on the Next button to continue. At this point of the installation you choose which Java 

Virtual Machine (VM) the program should use (Figure 5-17). If there are none already installed on your 

machine, or none detected that are the correct version for this program, you can choose to use the Java 

virtual machine included in the installer. Otherwise, you can choose one that is already installed on the 

computer. Auto-PERCIST™ requires Java version 1.7 or greater, and runs best on a 64-bit VM. 

 

Figure 5-17 Auto-PERCIST™ Installation Java VM Selector 

Click Next to select an installation location for the software (Figure 5-18). 
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Figure 5-18 Auto-PERCIST™ Installation Destination Folder 

Once again, you should allow the program to install itself in the default location and select Next. You will 

now be allowed to choose the location and type of program shortcuts to install (Figure 5-19).  

 

Figure 5-19 Auto-PERCIST™ Installation Shortcut Selector 

If there are multiple user accounts on the installation machine, you may want to select Create icons for 

All Users. All other options are at the user’s discretion. 

At this point all user installation options have been established and a summary of those options are 

presented in a text window of the dialog box. If you would like to change any settings you can do so by 

selecting the Previous button and re-selecting your options. If you are satisfied with the options you have 

selected you can proceed with the installation by click the Install button. 

The installation process will now proceed. Once completed, you should be able to close the dialog box to 

quit the installer. 
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In order to run Auto-PERCIST™ you must now obtain a license. 

5.3.1 Licensing 

Auto-PERCIST™ is licensed through a software license key which is specific to the 

machine on which it is installed. In order to obtain a license key you must first 

generate a request which contains encoded information specific to your 

computer which is used to generate the license key. In order to generate that 

request, run the License Manager program found in the AutoPERCIST program 

group, accessible via the Start menu (Figure 5-20, as found on Windows 7).  

!!! IMPORTANT: You should run the License Manager with administrative 

privileges for your machine so that the license file can be written to a protected 

application directory. 

When you run the License Manager you will once again be presented with a 

security dialog. Please respond in the affirmative. The program will check the 

system for a valid license key and, if not found, will present the user with an 

error dialog (Figure 5-21) from which they can either direct the License Manager 

to a location of a valid license key or generate the information required to request a license key. 

 

Figure 5-21 Auto-PERCIST™ License Manager Error Prompt 

If you do not have a valid license key and need to request one, select the Request License button to be 

presented with a license key request form (Figure 5-22). Complete the editable text fields of the form 

and select the Generate Request button. 

Please note that the “Machine ID” field will be unique to your particular machine! 

You can then select the Copy to Clipboard button and paste the contents of the request into an e-mail 

and send it to iratlab@jhmi.edu. A machine specific license key file will be sent by reply e-mail. 

Figure 5-20 Auto-PERCIST™ 
License Manager 

mailto:iratlab@jhmi.edu
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Figure 5-22 Auto-PERCIST™ License Manager Request Form 

Once you have received your machine specific license key file, re-run the License Manager program. This 

time, press the Load file button and navigate the file open dialog until you locate and select the 

autopercist.lic file. If the autopercist.lic file is valid, a dialog box will appear that reports so, otherwise 

record any resulting error message and send it in an e-mail to iratlab@jhmi.edu and we will attempt to 

correct the situation. 

At this point you should be able to run the Auto-PERCIST™ program! If the Auto-PERCIST™ program 

locates a valid license key file, the first dialog you will see is a Terms of Use statement (Figure 5-23). 

 

Figure 5-23 Auto-PERCIST™ Terms of Use 

mailto:iratlab@jhmi.edu
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You must agree to the Terms of Use each time you launch the Auto-PERCIST™ program. After you agree 

to the Terms of Use, the dialog will clear and the main application window of Auto-PERCIST™ will 

appear: 

 

Figure 5-24 Auto-PERCIST™ Main Application Window 

You are now running Auto-PERCIST™! 

5.3.2 Configuration 

While you can run Auto-PERCIST™ directly at this point, to make the experience of loading and saving 

data easier, there are a few configuration options which the user may want to make at this point. The 

user has the option of having all user settings saved into a default properties file when the program is 

exited via the File→Exit menu (by default all settings are saved in a file named autopercist.properties), or 

via the File→Properties menu option, where the current property settings can be saved to - or a 

previously saved property file can be loaded from – a disk file. 

!!! IMPORTANT: If at any time you experience a failure of Auto-PERCIST™ to start, especially following an 

upgrade or re-install, please delete the autopercist.properties file and try again. There is a known issue in 

which a corrupted or improperly formed autopercist.properties file can prevent the application from 

launching. 

5.3.3 DICOM Archive Connectivity 

While image data can be loaded directly from the file system, the easiest and most convenient way to 

access your PET data is by connecting to a locally installed DICOM archive (described in section 4.3 

above). In order to connect with that system, you will need to know the name, password and SQL server 

port number of the archive’s database. 
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To enter these settings into Auto-PERCIST™, select File→Load from DB menu.  

 

Figure 5-25 Auto-PERCIST™ File - Load from DB Menu 

You will be presented with a DICOM DB Query dialog box (Figure 5-26). From within this dialog you can 

configure your connection to the archive database. It will appear empty at first. 

 

Figure 5-26 Auto-PERCIST™ DICOM DB Query Dialog 
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Selecting the Show Options button will open the configuration panel of the dialog box (Figure 5-27). 

 

Figure 5-27 Auto-PERCIST™ DICOM DB Query Options Setup 

For connectivity via the MySQL database (the only one currently supported), select the 

com.mysql.jdbc.Driver in the Driver drop down box. If the MySQL database is running on the same 

machine as Auto-PERCIST™ leave the host setting as localhost. If you did not change the MySQL port 

setting during the configuration, leave it at the default setting of 3306. Enter the administrator user 

name (root) and the password you assigned for the MySQL server, then press Connect. At this time, the 

Database dropdown will populate with the names of the databases currently installed on your database 

server (Figure 5-28). 
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Figure 5-28 Auto-PERCIST™ DICOM DB Query Configuration 

There will be multiple entries even if you just installed the database for your Auto-PERCIST™ installation 

and haven’t created anything beyond the DICOM archive database. Locate and select the name of the 

database you created as part of the DICOM archive installation. In the example presented here, the 

name is apresults. Once you have selected your database you will need to tell Auto-PERCIST™ the 

directory within which the DICOM archive is storing the actual image files. Select the Image Dir button to 

open a File Directory dialog box (Figure 5-29) and navigate to the directory in which you installed the 

DICOM archive. Inside this directory you will find a subdirectory named data. Select that directory and 

press Open. 

 

Figure 5-29 Auto-PERCIST(TM) DICOM DB File Location Setting 
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The Image Dir text box will now be populated with the directory path to the image files stored in your 

DICOM archive. 

 

Figure 5-30 Auto-PERCIST™ DICOM DB Query Dialog 

The DICOM DB Query Dialog (Figure 5-30) allows you to quickly locate the study series you wish to load 

by navigating the data presented in a Tree diagram ( ) organized in the following hierarchy: Patient 

Name → Study → Series. The data can be sorted at the root level by either Medical Record Number 

(MRN) ( ) or by the patient’s last name ( ). The DICOM archive will store all valid DICOM data, though at 

this time Auto-PERCIST™ can only load PET modality data. This is evidenced by the fact that the Select 

button only becomes available for selection when you select a valid PET dataset. Once a valid data set is 

selected, the user can proceed with loading the data by either double-clicking the entry ( ) or pressing 

the Select button ( ). 

Update Note: As of version 0.6, Auto-PERCIST™ will now allow loading of multiple image series of 

multiple modalities simultaneously. However, visualization and disease modelling (derivation of 

candidate disease objects) currently only uses the first series loaded which must be an FDG-PET study, 

and all series are assumed to be in the same ‘space’. This is currently an experimental feature to allow 

the transfer of the ‘disease model’ from the ‘baseline’ study to propagate to ‘follow-up’ studies, but is a 
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feature which is not yet fully developed. Please refer to future documentation as this feature is further 

developed. 

At this point you can select a valid PET image set. Upon selection the dialog will close and Auto-

PERCIST™ will begin loading and processing the study. 

Depending on the speed of your computer, the left side of the application (Figure 5-31) will soon 

present the PET image dataset in the default Transaxial-Coronal-Sagital (TCS) display mode with the 

default Monochrome Look-up Table (LUT). After a bit more time the results of the Auto-PERCIST™ 

processing will appear in the table to the right side of the application. The first thing you will probably 

want to do is to configure the LUT table to your particular liking, as well as the display format and 

candidate lesion overlay color. 

Right-click on the graphic representing the LUT table and a pop-up menu will appear which will allow 

you to adjust the LUT settings. Clicking on the OVERLAY button will allow you to choose a color for the 

candidate lesion overlays. 

 

Figure 5-31 Auto-PERCIST™ Main Application Window 

5.3.4 Results Database Configuration 

If you wish to automatically save the results of your Auto-PERCIST™ analysis to an external database for 

further analysis and reporting, you can do so quickly and easily from within Auto-PERCIST™. The 

Database Server Settings dialog is access via the Options→Results→Database menu (Figure 5-32). 
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Figure 5-32 Auto-PERCIST™ File Results Database Menu 

 

Figure 5-33 Auto-PERCIST™ Database Server Settings 

This dialog (Figure 5-33) is configured in much the same way as the database configuration which 

connects Auto-PERCIST™ to the DICOM Archive database. First, select the correct driver with which to 

connect with the database (as before, only the com.mysql.jdbc.Driver is currently supported). If using 

the default MySQL database server installed locally (as described in section 4.1), keep the host and port 

settings at their default settings and enter the root username and password in the correct fields. Upon 

clicking the Connect button, the Database combobox will populate with the names of all the existing 

databases currently existing on the server. At this point you will probably want to create a new database 

to store your results. If you are working on multiple projects you may want to consider creating a unique 

results database for each project. Just be sure to connect to the proper database (or load a project 

specific properties file) for each analysis session. 
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In order to create a new database, just select the <create new database> entry from the Database list. 

You will be presented with a dialog in which you can enter a name for your results database (Figure 

5-34). 

 

Figure 5-34 Auto-PERCIST™ Create New Results Database 

After you select OK, you will get an error message stating that that particular database does not exist 

and asking if you’d like to create one with that name. Answer in the affirmative. If all goes well the main 

dialog will return to its prior state. You must then select your database from the Database combo-box 

and click the Close button. 

 

Figure 5-35 Auto-PERCIST™ Configured Database Results Dialog 

As stated earlier, once this setting is in place, as long as the user exits the program via the File→Exit 

menu, or by manually saving a properties file via the File→Properties menu, these settings will be 

retained between program runs. 

5.3.5 Results Options 

To a limited extent, you can control what Results data is exported to your Results database.  
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Figure 5-36 Auto-PERCIST(TM) Results Options Menu 

By selection the Options -> Results – Options menu (Figure 5-36), the user will be presented with the 

Results Options dialog (Figure 5-37). 

 

Figure 5-37 Auto-PERCIST(TM) Results Options Dialog 

In this dialog, the user can set global results settings, such as whether or not to use and save the patient 

MRN when saving the analysis results to the database ( ) and whether all candidate lesions, whether 

identified as disease or not, are saved to the database ( ) (a flag is set for each entry indicating whether 

the user classified it as disease or not for that particular analysis session). The font used in the display of 

the results table can be changed ( ). Finally, the user can select whether the lesions classified as disease 

be saved as DICOM Segmentation Objects. The user can decide to save them directly in the results 

database ( ) as a binary stream in DICOM format, and/or as individual DICOM files in a directory of the 

user’s choosing ( ). 

5.3.6 User Options 

The remaining user options are described in the next section. As stated before, all user options can be 

retained between program executions by either manually saving a properties file or exiting the program 

via the File→Exit menu and answering the ‘Save Properties File’ dialog in the affirmative. 
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6 USAGE 

Now that you have completed the installation and basic configuration of Auto-PERCIST™ it is time to 

start using it!  

To get started, you can load a PET image data set from either your connected DICOM archive 

File→Load from DB or directly from the file system File→Open. If you choose to open a dataset directly 

from the file system, select any PET image file from the list of files in the source data directory. The 

program will read the file you have selected and then scan all the other files in the directory to find 

those with matching Series UIDs and will build the series from the resulting set of images. Once you’ve 

loaded a dataset, you should have a display similar to the one below 

(

Figure 6-1).  
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Figure 6-1 Auto-PERCIST™ Main Application Window 

6.1 DISPLAY PANEL 
Let’s begin with a review of the left side of the application windows, the Display Panel ( ). There are 

essentially four components to the Display Panel: the Image Display window ( ), the Look-Up-Table 

(LUT) Control ( ), and the Image Display Controls ( ), ( ), ( )and ( ).  

6.1.1 Look-Up-Table Slider 

The LUT slider is a graphical representation and controller for the window-level settings for the display 

window. The system automatically calculates a preferred window-level setting based on the 

automatically derived normal reference tissue sample (discussed in Section 6.3.1 below). If this setting is 

not suitable to the user, the user can click and drag the top or bottom of the LUT slider to either stretch 

or shrink the window width. The LUT graphic can also be grabbed in the middle and moved up or down 

to adjust the Level. The key elements of the graphic control are shown here: 
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Figure 6-2 Auto-PERCIST™ LUT Control 

The units in which the image data has been converted to for internal processing are identified ( ). These 

are user selectable, depending on the system capabilities given the loaded data, and can be variants of 

SUV (LBM – Lean Body Mass, BSA – Body Surface Area, BW – Body Weight, or RAW). Setting the image 

units is described elsewhere in this manual (See section 6.3.1 below). The ( ) and ( ) buttons allow either 

expansion or contraction of the available dynamic range of the control. The default dynamic range of 

the control are the image data’s true minimum and maximum after conversion to the image units 

described by ( ). Similarly, the minimum value for the window is described by element ( ), represented 

as a percentage of the image data dynamic range. Item ( ) reflects the current position of the display 

window’s upper value represented as a percentage of the image data’s dynamic range. The display 

window’s upper value can be manipulated by selecting the top of the LUT graphic, located at position 

( ) and moving up or down. Similarly, the lower end of the window can be manipulated in the same way 
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by select the graphic at position ( ). The Level of the entire window can be manipulated by selecting the 

middle of the graphic at position ( ) and translating the LUT up or down the available dynamic range. 

The button identified as element ( ) allows the user to restore the LUT control to true image minimum 

and maximum. 

The actual LUT can be changed by right-clicking on the control and selecting a new LUT from the popup-

menu. The user can also choose to invert the current LUT from the same popup-menu. 

6.1.2 Image Display Controls 

The Image Display Controls available on the top of the display window include the layout manager, the 

overlay color selector and an Auto-Zoom toggle ( 

Figure 6-3 Image Display Controls - Top 

). 

 

Figure 6-3 Image Display Controls - Top 

The Layout dropbox ( ) allows the user to control how the image data is displayed (i.e., Axial, Coronal, 

Sagital, TCS or MIP). The user can select which color to render an overlay of the candidate disease 

objects by pressing the Overlay button ( ) and opening a Choose Overlay Color dialog. The user can 

either select a color by which the disease candidates will be rendered in the image display, or press 

either Cancel or close the dialog via the X button in the upper right corner to remove the overlay color. 

Finally, the user can select whether the system should automatically calculate the display zoom to fill 

the current workspace or allow the user to manually adjust the zoom level ( ). 

The Far Bottom of the Image Display Panel contains controls which are independent of the current 

image layout. They include toggle buttons which indicate whether the Normal Reference VOI should be 

displayed, whether a bounding cube should be displayed to highlight the disease object currently 

selected on the Results Table (See 6.2 below), and if the display should be auto-triangulated to the 

Normal Reference VOI.  
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Figure 6-4 Image Display Controls - Far Bottom 

The Right side of the screen contains an image zoom scroller for manual control of the display image 

zoom level. It is only active if the Auto-Zoom feature is unchecked. 

The Bottom of the Image Display Panel contains controls which will change depending on the currently 

selected layout. When a single plane view is displayed (e.g. Axial, Sagital or Coronal), it will display a 

single scroll control to allow you to select the displayed frame of data. When the layout is set to TCS 

(Transaxial-Coronal-Sagital), each display pane will have its own scroll control. Finally, when MIP (i.e. 

Maximum Intensity Projection) mode is selected, the controls will change to allow free rotation ( ), 

snap-to quadrant rotation ( ), and automatic, movie-mode projection ( ) with adjustable speed ( ). 

 

Figure 6-5 MIP Image Display Controls 

6.1.3 Image Display Window 

The Image Display Window, besides serving as the primary viewport to the image data, has several 

unique features and can be manipulated directly by the user through use of the mouse. 
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6.1.3.1 Transaxial, Coronal and Sagital Display Modes 

 

Figure 6-6 Auto-PERCIST™ TCS Display Mode 

In Figure 6-6, the display is in the TCS display mode format. The display has been auto-triangulated to 

the center of the automatically located normal reference tissue VOI ( ). Tissue objects with SUV-LBM 

values greater than the PERCIST threshold have been identified and are overlaid in blue. Cross-hairs 

indicate the current cursor position, while the voxel reporter on the bottom of the screen ( ) provides 

the coordinates and value for that particular voxel. 

By dragging the mouse the user can change the point of triangulation of the display. In addition, by 

rolling the mouse scroller (if one is available), the user can scroll through the stack of images which lie 

under the current mouse position. 

As mentioned before (6.1.2 above), the display of the normal reference tissue VOI can be turned off and 

on through the Display Options panel, as well as the color of the disease candidate overlays and the 

overall format of the display screen. 

6.1.3.2 Maximum Intensity Projection (MIP) Display Mode 

Auto-PERCIST™ is also capable of display the entire volume of data in a MIP display. This is illustrated 

below (Figure 6-7): 
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Figure 6-7 Image Display Window - MIP Layout 

In this mode, many of the display options are still available, although the mouse does take on a different 

behavior. The user can still control the display of the normal reference tissue VOI and the colorization of 

the disease candidate objects through the Display Options panel. However, the mouse now acts solely to 

manipulate the scrolling of the window through the projections. This can occur by either dragging the 

mouse through the field of view or by rolling the mouse scroller while the image display window has the 

mouse focus. 

6.2 RESULTS TABLE 
The Results Table (Figure 6-8) ( ), located on the bottom half of the right side of the application 

windows, is where all the action really occurs. In this table, each populated row of data represents a 

single candidate disease object which Auto-PERCIST™ has automatically pre-identified based on the 

specified criteria (the user can manipulate these criteria in the Options Panel described in Section 6.3 

below). This table is also connected to the Image Display Window on the left side of the screen to allow 

the use to quickly navigate through the study volume. 
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Figure 6-8 Auto-PERCIST™ Results Table 

By default, all candidate disease objects are pre-selected for display. If the ‘Display Disease Locators’ 

option ( ) is selected, then a bounding box ( ) will be drawn around the target object if it is selected in 

the Results Table ( ) by either clicking the row with the mouse, or selecting with the keyboard. Multiple 

objects can be simultaneously selected by manipulating the table as you would in most other programs 

(pressing SHIFT will allow a continuous range to be selected and pressing CTRL will allow a discontinuous 

range to be selected). If the Triangulate to Selection option is checked ( ), then the image display will 

automatically re-triangulate to the center of the target object of the last object selected. 

The user can select, or de-select, an object for display (and inclusion in any export of the results) by 

checking or un-checking the Use checkbox at the front of each table row ( ). After the user reviews each 

candidate object and makes a determination as to whether they are disease (checked) or normal tissue 

(unchecked), the image display will automatically update, only displaying overlays for the selected 

disease objects. 

6.3 OPTIONS PANEL 
While in most cases the user will want to use Auto-PERCIST™ with its default settings (auto-normal 

reference tissue detection, high-resolution VOI sampling, PERCIST baseline threshold, etc.), the user 

does have control over many aspects of the Auto-PERCIST™ process. 
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Figure 6-9 Auto-PERCIST™ Options Panel 

To begin with, there are two shortcut buttons on the top of the Options Panel (Figure 6-9) which allows 

the user to quickly put the program into either PERCIST Baseline ( ) or PERCIST Followup ( ) modes. The 

only difference between these modes is the method by which the disease assessment threshold is 

calculated.  

NOTE: When Auto-PERCIST™ is launched it reads a ‘Properties’ file (if one exists) which loads the default 

settings as last saved by the user (see Section 5.3.2). Thus, even if all the settings are equivalent to the 

default ‘Baseline’ or ‘Followup’ conditions, the application shows that ‘Custom Settings’ (C) are in effect. 

If during an analysis session the user decides to select the ‘Baseline’ (A) or ‘Followup’ (B) settings, then 

that button will be highlighted. 

In order to view the various system options the user will press the Show Settings button ( ), upon which 

a tabbed panel will open between the Options Panel and the Results Table (Figure 6-10). 
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6.3.1 Disease Threshold Panel 

6.3.1.1 Reference Sub-Panel 

 

Figure 6-10 Auto-PERCIST™ Options Panel - Disease Threshold Tab 

By default, the first option panel to appear is the Disease Threshold Panel ( ). This panel contains two 

sub-panels: Reference and Calculation, accessible via the tabs ( ) on the left. The Reference panel allows 

the user to set the image units ( ) in which the PET data should be converted into before processing 

takes place, as well as the algorithm used to calculate these values ( ). If DICOM is selected, then only 

basic information is used to derive the requested SUV values. If Vendor is selected, then the software 

will probe vendor specific fields in the file header to extract information such as residual dose, etc., 

allowing a more refined calculation of SUV to take place. 
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The Normal Tissue Activity Determination section is where the user can select the method by which the 

reference tissue VOI is placed within the image volume. The default option, Auto-Determined ( ) uses a 

method proprietary to Auto-PERCIST™ for locating and placing the normal reference tissue VOI within 

the liver. 

The Manually Positioned setting (Figure 6-11) ( ) allows the user to refine the placement of a VOI which 

had previously been placed using the Auto-Determined method. When selected, the user can drag the 

reference VOI in any of the planar display modes (Axial, Sagital, Coronal or TCS) with the mouse. Once 

the final positioning is selected, selection of the Lock Liver VOI Placement button ( ) will fix its position, 

preventing accidental re-positioning while navigating the display window with the mouse. 

 

Figure 6-11 Auto-PERCIST™ Normal Tissue VOI - Manual Positioning 

The user can also force the program to use a user provided value by selecting the Forced Value option 

(Figure 6-12) ( ).  Doing so will instruct Auto-PERCIST™ to use the user-specified value as the disease 

threshold without further manipulation. 

  

Figure 6-12 Auto-PERCIST™ Normal Tissue Activity Determination - Forced Value 

Once the user has made adjustments to how the normal reference tissue values are determined, they 

must press the Re-Detect ( ) button to instruct the program to re-analyze the image and re-identify 

disease candidate objects using the new normal reference tissue sample values. 
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6.3.1.2 Calculation Sub-Panel 

 

Figure 6-13 Auto-PERCIST™ Disease Threshold Calculation 

The disease assessment threshold, often referred to as the PERCIST Threshold, is defined as a derivative 

of the mean and standard deviation as measured by a 3cm diameter spherical VOI placed in the liver. 

PERCIST 1.0 (Wahl RL, et al., 2009) defines that derivative for baseline studies as: 

𝑃𝐸𝑅𝐶𝐼𝑆𝑇𝐵𝑎𝑠𝑙𝑖𝑛𝑒 = 1.5 ∗  𝑀𝑒𝑎𝑛𝐿𝑖𝑣𝑒𝑟 + 2.0 ∗  𝑆𝑡. 𝐷𝑒𝑣.𝐿𝑖𝑣𝑒𝑟 

This is sometimes referred to as the Baseline PERCIST Threshold. There are instances where an 

alternative method is used for calculating this assessment threshold. By selecting the Calculation tab 

(Figure 6-13) ( ) on the Disease Threshold option page, the user can select auto-calculation of either the 

PERCIST Baseline threshold ( ), the PERCIST Followup Threshold ( ), or their own manual linear derivation 

of the threshold based on the mean and standard deviation of the measured VOI ( ). 

If the user makes any change to the method by which the threshold is calculated, they must then press 

the Re-calc button ( ) for those changes to be reflected in the ‘Results Table’ and the image display. 
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6.3.2 Object Detection Panel 

The Object Detection panel (Figure 6-14) contains the user-accessible controls which drive the candidate 

disease object detection and delineation. 

 

Figure 6-14 Auto-PERCIST™ Object Detection Options Panel 

The first option defines the statistic which is used to identify the seed coordinates for the growth of the 

disease objects within the image volume ( ). The PERCIST criteria call for the default value of PEAK to be 

used. PEAK is defined as the local average of a 1cc spherical VOI centered over a given voxel. The other 

options include PAX (a derivative of PEAK and MAX), MAX (the hottest single voxel measurement), and 

Cluster (an experimental statistic which uses the mean of a user specified cluster of connected voxels). 

Once the seed coordinate is determined, the object is grown from that coordinate according to the 

options set forth in the Object Delineation section ( ). These include the Terrain – either image or 

detector map (default is image), the definition of 3-dimensional connectedness between voxels (either 
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6, 14, or 26 voxel connectivity), and the terminating condition for growth (the default is the PERCIST 

threshold as defined in the Calculation Sub-Panel (Section 6.3.1.1), though a user-specified percentage 

of the maximum detector is also allowed). 

The user can also select to tighten the criteria by which a detected object is deemed valid, and how 

many of these valid objects to detect ( ). By default, all objects are detected and reported. The user can 

also specify a minimum size (in voxels or real world volumetric measurement), and/or the minimum 

number of connections between the voxels within the object. 

As with other option settings, if the user changes the settings in this panel, they must force a re-

detection of disease candidate objects by pressing the Re-Detect button ( ). 

6.3.3 VOI Styles 

The VOI Styles options panel (Figure 6-15) allows the user to control the algorithm by which Auto-

PERCIST™ calculates the statistics it derives from spherical VOIs (e.g. PEAK, normal reference tissue 

sample, etc). 

 

Figure 6-15 Auto-PERCIST™ VOI Styles 

The primary section of this panel, ‘VOI Styles’ ( ) contains the four (4) algorithms available to Auto-

PERCIST™ for calculating spherical objects. The default method – Auto Hyper-Precise ( ) – is unique to 

the Auto-PERCIST™ program and allows the user to specify a spherical VOI by volume and a maximum 

percent error tolerance for that volume. For example, if the user were to specify that they wanted a 5cc 

sphere to be used with a 0.5% maximum error in measurement, then the program would sub-sample 

the voxel data until it was able to generate a measurable sphere with a volume between 4.995cc and 

5.005cc. The Manual Hyper-Precise ( ) option is similar, but allows the user to define the maximum sub-

sampling frequency to use. The Traditional method ( ) calculates spherical VOIs by including those 

voxels in the calculation whose centers-of-energy lie on or within the bounding surface of the 

designated spherical VOI. The Conservative method ( ) only uses those voxels which are entirely within 

the constraints of the bounding surface of the VOI. 
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The Cluster Calculation ( ) is experimental at this time, but allows the user to manipulate the 

connectivity algorithm used when determining the number of sub-objects which a candidate object may 

contain, and where the boundaries between these subjects may lie. 

6.3.4 Demographics 

The ‘Demographics’ panel displays key demographic data which might be useful to the user. This panel is 

for information purposes only.  

 

Figure 6-16 Auto-PERCIST™ Demographics Panel 

The only option available to the user on this panel is the button entitled Display DICOM Fields’ ( ). By 

selecting this button, a new windows will pop-up which will provide the user the ability to peruse all the 

DICOM fields contained within the dataset. This is primarily provided for testing and debugging 

purposes. 
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6.3.5 Messages 

The right-most panel is the ‘Messages’ panel (Figure 6-17). Within this panel, all informational and error 

messages are logged. 

 

Figure 6-17 Auto-PERCIST™ Message Panel 

The title tab for the panel ( ) will turn red if unread messages exist in the panel. Selecting the tab which 

brings focus to the panel will clear the color of the tab title. The Warning ( ) and Errors ( ) settings 

determine which categories of errors are displayed in the text area of the panel. The Clear button ( ) will 

erase all current entries in the panel, while the Save button ( ) will allow the user to save the text within 

the panel to a text file. This is useful for debugging purposes. If the user encounters an unexplained 

error it would be useful to save the messages and send a copy of the data and error messages to the 

Auto-PERCIST™ authors for analysis.  

7 ADVANCED AND EXPERIMENTAL FEATURES 

There are currently two features available to the user which are only available through the keyboard, 

and therefore don’t present themselves obviously through the user interface. The ability to either erode 

a candidate disease object into multiple objects using an algorithm unique and proprietary to Auto-

PERCIST™, or the inverse where multiple separate and distinct objects can be combined into a single 

object for consolidated quantitative purposes. An example case is described below: 
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Figure 7-1 Auto-PERCIST™ Candidate Lesion Selection 

 In this example case, two candidate lesions have been selected by the user as valid disease objects 

(Figure 7-1). The second object (#0008) is currently selected by the user. If the user were to press 

the  E  key on the keyboard, the program will perform its proprietary erosion operation which will 

separate the object into two or more discrete objects (Figure 7-2). 

 

Figure 7-2 Auto-PERCIST™ Candidate Lesion Erosion 

Object #008 from Error! Reference source not found. has now been eroded into two separate objects 

(#008 and #009) in Error! Reference source not found., each separately characterized and selectable by 

the user. 

NOTE: The ‘separately’ of an object can be pre-calculated by activating the “Pre-calc Sub-Clusters” option 

in the Options → Processing → Pre-Calc Sub-clusters menu. Once enabled, a ‘Clusters’ column will appear to 

the far right of the ‘Results Table’ after a re-processing of the data has occurred, and provides a preview 
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of the number of sub-objects a given object can be separated into by this algorithm. This feature is 

experimental and can significantly increase the computation time required for object identification and 

characterization. It is disabled by default. 

The inverse capability exists by selecting multiple objects and pressing the  C  key on the keyboard to 

combine multiple objects. For example, the user can select multiple objects simultaneously by holding 

the  CTRL  key while clicking on the rows of the individual objects they wish to combine in the Results 

Table (Figure 7-3). 

 

Figure 7-3 Auto-PERCIST™ Candidate Lesion Multi-Select 

Pressing the  C  key on the keyboard will combine the different object into a single object (#0008) with 

no loss of data (Figure 7-4). 

 

Figure 7-4 Auto-PERCIST™ Candidate Lesion Consolidation 
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8 RESULTS REPORTING 

8.1 EXPORTING OF RESULTS 
As described elsewhere (Section 5.3.4 above), the summary information contained in the Results Table, 

as well as much more detailed information can be exported for further analysis. 

 

Figure 8-1 Auto-PERCIST™ Exporting Results 

To export the data to an external database, the user can click the Report to DB button (Figure 8-1) ( ) 

which will transfer the displayed summary data as well as a much more extensive selection of data to a 

pre-configured SQL database. A similar exportation of the Auto-PERCIST™ processing results can be 

exported into a text file, suitable for importing into a spreadsheet, by clicking the Report to Text button 

(Figure 8-1) ( ).  

 

Figure 8-2 Auto-PERCIST™ Results Table Selection via <Ctrl><A> 

Finally, the contents of the Results Table can be selected by clicking anywhere within the Results Table 

and pressing the  Ctrl   A  keyboard combination (Figure 8-2). The user can then press  Ctrl   C  to copy the 

contents to the clipboard, and  Ctrl   V  to paste the data into another program, such as a spreadsheet or 

other analysis package. 

!!!Note: Keyboard combinations for copy-and-paste represented here are specific for the Windows 

platform! If you are running Auto-PERCIST™ on a different platform, use the keyboard combinations 

specific for your system. 
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!!!Note: When copying the Results Table using the copy-and-paste methods, ONLY the data shown on 

screen is copied, and not the extensive array of data which is available to you through the database 

and/or text file export methods. 

8.2 EXAMPLE MICROSOFT ACCESS RESULTS DATABASE 
Provided with the beta-release of Auto-PERCIST™ is an example Microsoft Access database with which 

you can generate some basic summary and analysis reports of your Auto-PERCIST™ results which have 

been transferred to a previously defined database. In order to fully enable this capability, a few 

configuration steps need to be performed. 

!!!Note: These examples use Microsoft Access 2007. If you are using a more current version your screen 

display may appear different. The basic functionality is the same. 

!!!Note: It is recommended that you use this example reporting database as an example of what you can 

do with your Auto-PERCIST™ results, but not necessarily as your final reporting tool. It is provided solely 

as an example. 

8.2.1 Create ODBC Connector to MySQL Server 

!!!Note: Depending on your system settings, you may require ‘Administrative’ privileges to perform the 

following actions. 

!!!Note: Misconfiguration of your system may disable or severely impair the functioning of your 

computer. If you are not comfortable with making these settings it is recommended that you ask an IT 

administrator for assistance. In particular, driver mismatches between your version of Windows and your 

version of Microsoft Office may require special configuration settings which are not described here. 

The first step is to create a connector so that the Microsoft Access database can “speak” to the MySQL 

database you already created (Section 5.3.4) as a repository for your Auto-PERCIST™ results. On 

Microsoft Windows systems, this is achieved by running the “Data Sources (ODBC)” applet which can be 

found in the “Administrative Tools” section of the “Control Panel”. 
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Figure 8-3 Windows Administrative Tools 

Upon running the “Data Sources (ODBC)” configuration tool (Figure 8-3), you will be presented with an 

ODBC configurator dialog box (Figure 8-4).  

 

Figure 8-4 Windows ODBC Data Source Administrator 

!!!Note: The system dialog boxes used in this example may not appear the same as on your system, 

depending on the version and service pack of your system. 

You will create your connector here. If you want your database connection to be limited to your user 

account you will create your connector in the User DSN tab ( ). If you want your connection to be 

shared across all users of the computer, you will create it in the System DSN tab ( ). 
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To create the database, select the appropriate environment – User DSN or System DSN and press the 

Add button ( ). This opens the Create New Data Source dialog (Figure 8-5). 

 

Figure 8-5 Windows Create New Data Source 

!!!Note: The contents of your dialog may appear very different than the contents of the examples 

presented here. However, the functionality should be the same. 

One or more suitable connector drivers were already installed on your systems when you originally 

installed the MySQL database (Section 5.1 above). You may find multiple ‘MySQL ODBC’ drivers ( ). 

Select one with the highest version number and in the appropriate language for you (if multiple 

language versions exist in your installation). Once you have selected the appropriate driver, click Finish 

( ) to configure your connection. 

 

Figure 8-6 MySQL Connector/ODBC Data Source Configuration 

The MySQL Connector dialog will present itself (Figure 8-6) and will initially be empty. You will need to 

provide a name for your connection ( ), and you can also provide a more elaborate description of your 
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database if so you desire ( ). If the MySQL server is installed on this same machine, you can enter the 

phrase localhost in the TCP/IP Server address box ( ). If the MySQL server is on another machine, you 

would need to enter that machine’s TCP/IP address. The network Port address should already be 

configured with the default setting for MySQL – 3306 ( ). If you or your Database administrator have 

configured your system with an alternative setting, please enter it here. You will need to enter a user 

name ( ) and user password ( ) for an account on the MySQL server which has the appropriate privileges 

to access the database. This is most often the same account as was used when the database was 

created, but it does not need to be. Once these fields are populated you can connect with the server by 

pressing the Test button ( ).  

 

Figure 8-7 MySQL Connector/ODBC Data Source Configuration 

If you were able to successfully connect with the MySQL server, the Database combobox will populate 

with a list of the databases available to you on the server (Figure 8-7). Select the database you created 

earlier which contains your Auto-PERCIST™ results and press OK. 
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Figure 8-8 ODBC Data Source Administrator 

You have now created an ODBC connection to your MySQL database (Figure 8-8). This will allow you to 

connect the example Microsoft Access report tool to your database! 

8.2.2 Attach the Example Microsoft Access Report tool to ODBC Connector 

You will need to connect the example Microsoft Access Report tool to the ODBC connector. To do so, 

you must already have Microsoft Access installed on your computer and have it properly configured to 

allow the macros and code built-in to the tool to execute. If you are not familiar with how to do this you 

may need to contact your local IT support. 

 

Figure 8-9 Microsoft Access External Data Import Menu 
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Once you have open the Report tool, you will select the External Data main menu item (Figure 8-9) ( ). 

From that item, in the Import section, you will find a drop-down button named More ( ). Select this 

button and select ODBC Database from its options ( ). 

 

Figure 8-10 MS-Access Get External Data - ODBC Database 

You will now be asked how you wish to import the data (Figure 8-10). You can either copy the data 

directly into the report tool ( ), or create an active link to the data ( ). If you are still acquiring data in 

this database, it would be best to create the active link ( ). However, if you are done acquiring data and 

want to copy the report tool populated with your data to another system, you will need to use the copy 

option ( ). Once you have made your selection, press the OK button to proceed. 

You will now be asked to select the data source with which you want to connect (Figure 8-11). 
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Figure 8-11 MS-Access Select Data Source 

You will want to select the Machine Data Source tab and the ODBC database connection which we 

created earlier (Section 8.2.1 above). Once you have selected, you should see the following Link Tables 

dialog (if you are performing a link operation, otherwise the dialog will be named Import Objects, 

though it will appear and function in a similar fashion) (Figure 8-12): 

 

Figure 8-12 Link Tables 

The only information you will want to either link or copy into the report tool is the table data, so you will 

first Select All table data ( ) and then accept the selection by pressing the OK button ( ). 

You have now either copied or linked your report tool to your Auto-PERCIST™ results database! 

There are two primary reports and one informational report available to you in this example report tool. 

You can access all three by opening the Switchboard form (Figure 8-13).  
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Figure 8-13 Example Report Tool Switchboard 

From this interface, you can review an example Quality Review report, a PERCIST Response report, and an 

informational summary of the available database fields. 

The report tool provided is just an example of the type of reporting you can do with the data generated 

by Auto-PERCIST™. You will most likely want to develop your own reporting tools to suit your individual, 

or project, needs. 
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9 TROUBLESHOOTING 

9.1 FAILURE OF THE MAIN APPLICATION WINDOW TO APPEAR 
If the main application fails to appear after attempting to run the program, the application properties 

file (usually named autopercist.properties) may have been corrupted. This file should be deleted and 

execution of Auto-PERCIST™ re-attempted. The default directory for this file is the user’s home 

directory. 

9.2 MEMORY ERRORS 
Auto-PERCIST™ works best in a 64-bit environment with access to plenty of RAM memory. Memory is 

usually not a concern when running on a 64-bit environment, but if you have deployed Auto-PERCIST™ 

on a 32-bit environment with limited RAM memory, you may benefit by modifying the startup 

configuration to guarantee a suitable amount of memory is available to the application. 

There are two types of memory which Auto-PERCIST™ requires to successfully execute, HEAP and 

STACK. The HEAP is the global memory pool for data objects (like images, bitmaps, etc.). The STACK is a 

separate section of memory which is used by the application for temporary use as it performs its various 

processes.  

By default, Auto-PERCIST™ is configured to request 4MB of RAM for its STACK space. If you get memory 

errors – specifically OUT OF STACK errors - you can change the default configuration of Auto-PERCIST™ 

by editing the file Auto-PERCIST.lax which is found in the installation directory for Auto-PERCIST™ (on 

Windows computers this is usually C:\Program Files\AutoPERCIST\). 

WARNING!!! Editing the ‘.lax’ configuration files of your Auto-PERCIST™ installation could disable your 

installation altogether. Only do so if you are comfortable with advanced Java Virtual Machine settings!!! 

Within the Auto-PERCIST.lax file, there is a variable named ‘lax.nl.java.option.additional=’ which 

specifies the default memory options for the Java Virtual Machine used by Auto-PERCIST™. The default 

stack size is specified as 4MB (via an option string which looks like ‘-Xss4m’). Increasing the STACK size 

will allow more complex objects to be detected by increasing the system’s ability to perform recursive 

operations. 

If you are running Auto-PERCIST™ on a 32-bit virtual machine and are running out of HEAP memory, as 

evidenced by any other type of OUT OF MEMORY error, you can increase the HEAP memory pool 

available to Auto-PERCIST up to the maximum allowed by your specific Java™ Virtual Machine 

implementation, by adding a line such as ‘-Xms2G’ to the ‘lax.nl.java.option.additional=’ setting in the 

Auto-PERCIST.lax file as described for the STACK memory setting. The ‘2G’ indicates that 2 GB of RAM 

memory should be reserved for the application at startup and, if that amount of memory is not 

available, then the application will fail to launch. 
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9.3 OTHER ERRORS 
Other errors should be documented by saving the message log to a text file (described in Section 6.3.5) 

and sending them, along with the appropriate data to replicate the problem (if possible) to the authors 

at iratlab@jhmi.edu. If the amount of data is too large to transmit via e-mail, arrangements can be made 

for an FTP transfer. 

mailto:iratlab@jhmi.edu
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